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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 
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BASS ist das Acronym für Basic Astronomical Spectroscopy Software und wurde von John Paraskeva 
entwickelt. Als freie Microsoft Windows basierte Anwendung ermöglicht BASS die vollständige Reduktion, 
Kalibrierung und eine weitgehende Auswertung von Spektren. 
  
https://groups.io/g/BassSpectro 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

1. Der vorliegende Datensatz: Gamma Cas - und Ne/Xe-Referenzspektrum 

Datensatz: Acht Aufnahmen von  Cas (je 4s belichtet) und eine Aufnahme des Neon/Xenon-

Referenzspektrums, 300s belichtet. Die Spektren wurden mit dem DADOS Spaltspektrografen mit jeweils 

einem Autodark, aber ohne Flat aufgenommen. Das Gitter mit 200 L/mm ermöglicht bei einer Kamera-

Sensorbreite von ca. 18mm die Aufnahme des kompletten sichtbaren Spektrums von 3500Å bis in den 

Infrarotbereich ca. 10000Å. 

 

Das Referenzspektrum wurde mit der im Handel erhältlichen „Magic Plasma Röhre“ von Conrad Electronic 

aufgenommen. Zur Aufnahme des Referenzspektrums strahlte die Lampe von vorne durch das Teleskop. 

https://www.conrad.de/de/plasma-party-lichteffekt-magic-plasma-roehre-pink-anzahl-leuchtmittel-1-591136.html  

Folgendes ist bei der Aufnahme grundsätzlich zu beachten: 

Referenzspektren und Objektspektren müssen zeitlich nah beieinander aufgenommen werden. Grund: Der 

Spektrograf dehnt sich aus oder zieht sich zusammen, wenn sich die Außentemperatur ändert. Deshalb lässt 

man den DADOS und das Teleskop zunächst eine halbe Stunde auskühlen, bevor man beginnt. Zuerst wird ein 

Referenzspektrum aufgenommen, dann eine Serie von Objektspektren und zum Schluss wieder ein 

Referenzspektrum. Ausnahme: Im vorliegenden Fall wurde nur ein Referenzspektrum am Ende der Serie 

aufgenommen. Im niedrigauflösenden Anwendungsbereich ist das auch völlig ausreichend, weil thermische 

Driften in der vorliegenden Serie 

nicht zu erkennen sind. Außer-

dem sollte der Spektralfaden 

bereits möglichst exakt horizontal 

orientiert sein, blaues Ende links, 

rotes rechts. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

1.1 Vorbereitung der Spektren: Spektren beschneiden um Datenmenge zu begrenzen  
 

Referenz und Sternspektren liegen vorbereitet in diesem beschnittenen Bildformat vor. Das Ausschneiden und 

Abspeichern erfolgte in unserem Beispiel mit MaxIm DL. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hinweis: Die BASS 32-Bit-Version ist nicht in der Lage größere Datenmengen im RAM zu verwalten. 10 Spektren 

à 16MB Speichervolumen sind bereits zu viel. Für diese Version wird empfohlen, die Spektren vor der 

Weiterverarbeitung in BASS in Bezug auf die Höhe zu beschneiden. Dies muss jedoch für alle Spektren in selber 

Weise erfolgen! Jedes Programm zur Steuerung einer CCD-Kamera sollte in der Lage sein, dies vorzunehmen. 

Hinweis: Die BASS 64-Bit-Version ist hingegen in der Lage, größere Datenmengen zu verwalten. Tritt dennoch 

ein Speicherfehler auf, sollten die Spektren vorher beschnitten werden.  

Zunächst wird der Spektralfaden in der Höhe etwas beschnitten. Da  Cas auf dem 25m-Spalt liegt, wird nur 

der mittlere Spektralfaden ausgeschnitten.  

Hinweis: Der Spektralfaden darf nicht zu eng ausgeschnitten werden. Ober- und unterhalb muss noch Raum 

sein, um später den Bereich des Himmelshintergrundes zu definieren. Außerdem kann es sein, dass die 

Spektren in vertikaler und horizontaler Richtung etwas gegeneinander verschoben sind. Ein größerer freier 

Bereich über, bzw. unter dem Spektrum sollte vorhanden sein. 

Hinweis: Legen Sie eine Kopie des Datensatzes an.  

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              4 

 

 
Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

2. BASS starten 
 

Dieses Tutorial setzt voraus, dass Rohspektren im Ordner C:/astrobodger/gamma_Cas/2013-10-24/…. im 

Format FIT vorliegen. Diese wurden im Rahmen des Herbstkurses Sternspektroskopie 2013 am CFG Wuppertal 

mit einem Celestron 11 EdgeHD-Teleskop und MaxIm DL aufgenommen; bei der Aufnahme wurden 

automatische Darkframes subtrahiert. Flats wurden nicht gemacht. Das gamma-Cas-Spektrum wurde achtmal 

mit dem mittleren 25m-Spalt aufgenommen. 

  

Start der aktuellen Version BASSProject.exe im Ordner C:\astroboger 

Das leere Arbeitsfenster eines neuen Projekts in der BASS 64-Bit-Version: 

 

BASS arbeitet mit sogenannten „Projekten“, bei denen alle verwendeten 2D-Rohspektren, Ergebnisse und 

Beschriftungen gespeichert werden an einem festen Speicherort, C:/astrobodger. Projekte werden im Format 

.bass abgespeichert. BASS meldet sich, wenn Teile des Projekts (neue oder geänderte Spektralprofile) noch 

nicht gespeichert wurden und fordert dann dazu auf. Änderungen an vorhandenen oder neu erzeugte 

Spektralprofile werden im Format .fit (bzw. .dat) abgespeichert. Das FITS-Format ist umfangreicher als das 

DAT-Format, weil zusätzlich zu den Datenzeilen x,y auch alle wichtigen sonstigen Informationen gespeichert 

werden: Datum, Uhrzeit, Belichtungszeit, Aufnahmeort, etc.  

Hinweis: Der Begriff „2D“ bedeutet in der Spektroskopie, dass es sich um ein Foto des Spektrums handelt, so 

wie man es am Teleksop aufnimmt. „1D“ ist der aus dem Foto erzeugte Spektralprofil, welches nur ein 

Datensatz mit zwei Spalten ist: x =Position entlang des Sensors, y=Intensität in y-Richtung aufsummiert.  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

3. Spektren stacken mit Alignment 
 

➔ Stack Images 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Erstes Bild gamma Cas 1.fit anwählen  

➔ [Align images] Die Spektren #1 bis #8 sind in der Höhe leicht versetzt und zudem in x-Richtung um 

maximal einen Pixel verschoben. Damit ergibt sich im Vergleich zum fixen Referenzspektrum eine 

minimale Verschiebung, die vermutlich auf ein nicht fest geklemmtes Gitter zurückzuführen ist. 

➔ Clear alignment points: Sicherheitshalber vorhandene alte „Points“ löschen. 

➔  Helligkeit/Kontrast 

evtl. anpassen. 

➔ Stack. Die Alignment wird 

grafisch dargestellt 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

 

➔ Crop X-Axis Range: Beschneiden des Spektrums in x-Richtung. 

 

 

➔ Das Ergebnis: Ein Summenbild von acht Einzelspektren von  Cas, 

allerdings noch ohne Subtraktion des Himmelhintergrundes. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

  

➔ Image Strip View -> Raw Image 50% 

 

Erläuterung: Die x-Achse („Pixels uncalibrated“) entspricht der Pixelposition in horizontaler x-Richtung auf dem 

Foto. Dieser Pixelwert muss in einen Wert für die Wellenlänge  (Lambda) umgerechnet werden. Die 

Ermittlung des funktionalen Zusammenhangs zwischen Pixelposition (x) und Wellenlänge () in Form eines 

Polynoms höheren Grades =f(x) bezeichnet man als Wellenlängenkalibrierung. 

Die y-Achse („Flux“) gibt die Intensität an einer bestimmten Pixelposition im 1D-Spektralprofil an. Diese 

Intensitätskurve wird auf zwei Arten kalibriert:  

a) Beseitigung des Pseudokontinuums (Normierung auf „1“).  

b) Absolutkalibrierung (Flusskalibrierung) mit Hilfe eines Referenzspektrums.   
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

4. Voreinstellungen vornehmen 
 

➔   Kopiere den griechischen  

               Buchstaben  (gamma). 

 

 

 

 

 

 

 

 

➔   Project Chart Settings: Hier alle Daten eingeben.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Main Title und Sub Title speichern 

 

Chart width: CFG-Medion-Notebooks ca. 1150 / Chart height: 450 (hängt von der Größe des Bildschirms ab) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

 

 

Chart width: CFG Medion-Notebooks ca. 1150 / Chart height: 450 (hängt von der Größe des Bildschirms ab) 

 

… und am Ende das Anwendden und Speichern nicht vergessen → Apply → Ok 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

 

 

➔  Speichern des gestackten Bildes: C:/astrobodger/gamma_Cas/2013-10-24/gamma Cas.fit 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔   Speichern des Projekts unter dem Namen C:/astrobodger/gamma_Cas/2013-10-

24/gamma Cas.bass 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Prüfen, ob Projekt korrekt gespeichert ist: New Projekt  → Open Project   

 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              12 

 

 
Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

5. Referenzspektrum öffnen 
 

➔  Open Image Files    

➔ NeXe Reference.fit  

 

 

 

 

 

 

 

 

                                     

        #01 (Blau): Spektrum  Cas, #02 (Grün): Referenzspektrum der NeXe-Lampe. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

➔  Speichern des Projekts unter dem Namen C:/astrobodger/gamma_Cas/2013-10-24/gamma 

Cas.bass 

 

Jetzt Positionen tauschen: Das Referenzspektrum muss an Position 1 gelangen. 

 

➔ #02 aktivieren -> Rechte Maustaste -> Sequence -> 01 

 

Nach dem Tausch der Position ist dies die neue Reihenfolge:  

 

Hinweis: Jetzt nochmal Crop X-Axis Range ausführen mit 

Min=200, Max=2600 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

6.  Gamma Cas Spektrum und Referenzspektrum horizontal ausrichten. 
 

➔ Spektrum Stack8Images umbenennen in gamma Cas  

➔ gamma Cas aktivieren 

➔ Image Strip View 50%  

➔ Falls zu dunkel: Image → Black & White Levels 

➔ Image → Rotate/Tilt correction 

 

 

 

 

 

 

 

 

➔ Select Option → Select Region, Tilt Image, Emission wählen. 

➔ Dann mit der Maus einen Rahmen aufziehen entlang des Spektrums. 

 

➔ Apply 

➔ Close 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Nun sind alle Spektren gleichermaßen horizontal ausgerichtet.  

Hinweis: Im Falle geneigter oder gebogener Spektrallinien muss die Funktion Tilt Image bzw. Horizontal Smile 

ausgeführt werden. Die Neigung der Referenzlinien im vorliegenden Spektrum ist in bezug auf die geringe 

Höhe des Sternspektrums zu vernachlässigen. Bei einem hochaufgelösten Spektrum würden man die Neigung 

ggf. korrigieren.  

 

➔              Abspeichern der soeben gedrehten beiden Spektren: Save the selected image strip (selbe Namen)  

 

 

 

➔ Speichern des Projekts:  unter dem selben Namen gamma Cas.bass 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

7. Spektralbereich eingrenzen -> Crop X-Axis Range  
 

➔   Mit der linken Maustaste einen Pixel-Bereich aufziehen von 200px bis 3000px. 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Apply -> Close -> Ok 

➔ Falls noch nicht: Caption des Profils #2 ändern:  

StacK8Images -> gamma Cas 

➔ Projekt speichern 

 

8. Auswahl des Scanbereichs für Spektrum und Himmelshintergrund 
➔ Spektrum #02 auswählen 

➔ Image Strip View: 100% 

➔ Selection → Region Selection Tool  

 

 

 

 

 

 

Es erscheint das Menüfenster Region Selection Tool. 

➔ Active Binned Region (Sternspektrum definieren) 

➔ Ziehe nun einen Rahmen innerhalb des Spektrums auf 

➔ Update 

 

 

 

 

 

 

 

 

 

(Rahmen aufziehen) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

➔ Verändere die Werte für Y Start und Y End, bis der Rahmen das Spektrum in nahezu voller Höhe 

umfasst. Die Breite wird automatisch angepasst. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Update 

Nun werden die beiden Regionen für den Himmelshintergrund oben/unten automatisch definiert: 

 

                Hinweis: Bildschirm-Refresh nicht vergessen!!  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Alternative zur Automatik: Manuelle Festlegung der beiden Himmelshintergrundbereiche oben/unten: 

➔ Substraction Region 1 (für Himmel „oben“, also oberhalb des Siriusspektrums) 

➔ Rahmen aufziehen für Himmel „oben“ 

 

 

 

 

 

 

 

 

 

 

 

➔ Update 

➔ Substraction Region 2 (Himmel „unten“, also unterhalb des Siriusspektrums) 

➔ Rahmen aufziehen für Himmel „unten“ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Update 

➔ Close 

Und das ist das Ergebnis der Festlegung der Bereiche:  

 Bildschirm-Refresh nicht vergessen!! 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

Zurück zur Gesamtansicht: 

 

 

Nun wird die „Active Binning Zone“, also der Bereich des Sternspektrums  Cas, der gescannt wird, auf das 

Referenzspektrum übertragen: 

➔ Mit rechter Maustaste in das Spektrum 01: NeXe Reference.fit klicken 

➔ Copy Active Binned Region from 

➔ 02: gamma Cas 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Ergebnis: Es sind alle benötigten Bereiche in beiden Spektren definiert:  

 

 

➔   Speichern des Projekts unter dem selben Namen gamma Cas.bass 

 

Falls gewünscht, in der Bildbeschriftung ggf. nun die Namensänderung vornehmen:  

➔ Spektrum #02 aktivieren mit Mausklick 

 

➔  Buchstaben „“ kopieren: 

 

 

 

 

 

 

 

 

 

➔   Profile Properties: 02 gamma Cas   

➔ Neue Captions:  Cas bzw. Ne/Xe Referenzspektrum für Spektrum #01 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

9. Wellenlängenkalibrierung 

9.1 Das Spektrum der Neon/Xenon Referenzlampe 
Die Wellenlängendatei befindet sich im Ordner c:/astrobodger/Reference/NeXe Plasmatube.dat 

 

 

9.2 Wellenlängenkalibrierung der Ne/Xe-Referenzlampe 
Dies sind die hier verwendeten acht Referenzlinien mit Ergebnis der Kalibrierung.  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

➔ 01: Ne/Xe Referenzspektrum aktivieren 

➔  Profile Properties -> Y-Axis -> Automatic Scaling 400% -> Apply -> Ok  

 

➔  Enter Line Calibration Mode                             

 

 

➔ Erste Referenzline 4582.7472Å eng eingrenzen 

 

➔ Element filter: Ne/XePlasmatube 

 

 

➔ Xe  – 4582.7472 wählen 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔ Add Another Point 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Referenzline eng eingrenzen: 5028.279Å 

➔ Xe – 5028.279 wählen 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔ Add Another Point 

 

 

➔ Dritte Referenzline eng eingrenzen: 5852.488Å 

➔ Xe – 5852.488 wählen 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔ Add Another Point 

 

 

➔ Vierte Referenzline eng eingrenzen: 6532.882Å 

➔ Ne – 6532.882 wählen 

➔ Calibration fit umstellen auf 2 Quadratic (Polynom zweiten Grades). Restfehler bisher: 0.134Å 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔ Add Another Point 

 

➔ Fünfte Referenzline eng eingrenzen: 6598.953Å 

➔ Suggest schlägt Ne – 6598.952 vor 

➔ Calibration fit umstellen auf 3 Cubic (Polynom dritten Grades). Restfehler bisher: 0.0073Å  

➔ Wenn wir uns darauf beschränken würden, nur bis zu H zu kalibrieren, könnten wir die Kalibrierung 

mit Finish beenden.  

➔ In diesem Fall möchten wir jedoch das Spektrum bis in das Infrarote hinein weiter kalibrieren 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔ Add Another Point 

➔ Sechste Referenzline eng eingrenzen: 7032.41Å 

➔ Suggest schlägt Ne – 7032.41 vor 

➔ Calibration fit umstellen auf 3 Cubic (Polynom dritten Grades). Restfehler bisher: 0.059Å  

 

 

➔ Add Another Point 

➔ Siebte Referenzline eng eingrenzen: 8409.189Å 

➔ Suggest schlägt Xe – 8409.189 vor 

➔ Calibration fit umstellen auf 4 Polynomial (Polynom vierten Grades). Restfehler bisher: 0.11Å  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔ Add Another Point 

➔ Achte Referenzline eng eingrenzen: 8819.41Å 

➔ Suggest schlägt Xe – 8819.41 vor 

➔ Calibration fit mit 4 Polynominal (Polynom vierten Grades). Restfehler bisher: 0.22Å  

Es ist nicht sinnvoll, hier einen höheren Polynomgrad 

als 4 zu wählen. Der Dispersionsverlauf des 

Spektrografen entspricht einer flachen Kurve, die 

sich nur gerinfügig von einer linearen Funktion 

unterscheidet. Die Dispersion beträgt 2.15 Å/px, so 

dass wir mit einer anfänglichen Kalibriergenauigkeit 

von RMS 0.22 Å/px sehr zufrieden sein können; 

insbesondere, wenn man den überspannten 

Spektralbereich in Betracht zieht. Kleinere Intervalle 

können mit höherer Genauigkeit kalibriert werden. 

Aber wir können probieren, die Genauigkeit durch 

Löschen der ungenauesten der acht Linien zu 

erhöhen.  

 

 

Ab Version 1.9.8b4 geht auch folgendes: Man setzt 

ein Minuszeichen vor die Pixelposition einer Linie, die nicht berücksichtigt werden soll. Nach viermaligem 

Drücken auf die Tabulatortaste wird die neue Berechnung durchgeführt. Oder man klickt in eine Zeile darüber 

oder darunter. Mit Löschen des Minuszeichens kann die Linie wieder aktiviert werden.   

 

Die Wellenlängenkalibrierung verbessert sich 

erheblich auf RMS=0.023Å 

➔ Finish 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              29 

 

 
Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

9.3 Übertragung der Wellenlängenkalibrierung auf das Spektrum von  Cas 
 

➔ 02:   Cas anwählen 

➔  Profile properties 02: g Cas 

➔ Use Calibration from first profile 

➔ Copy 

➔ Ok 

➔ Apply 

➔ Ok  

 

 

 

 

 

➔ Image Strip View umstellen auf Synth Color stretched (synthetisches Sternspektrum) 

➔  Speichern des Projekts unter dem selben Namen gamma_Cas_200L.bass 

 

 

➔ Show/Hide Calibration Points: Schaltet die Anzeige der Kalibrierpunkte ein und aus! 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

➔ Ausblenden des Referenzspektrums #01:  

➔ Spektrum 02:  Cas mit der Maus aktivieren: 

 

 

➔  Measurements and Element Lines.  Hiermit kann man seine Kalibrierung gezielt an einzelnen 

Linien oder einer ganzen Linienserie überprüfen. Beispiel: Einblenden der Balmerserie des 

Wasserstoffs.  

➔ Mit Clear entfernt man alle Markierungen wieder. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

10. Normierung der Intensität des Spektrums 
 

Der Intensitätsverlauf des wellenlängenkalibrierten Spektrums stellt nicht den wahren Kontinuumsverlauf dar. 

Dieser wird durch verschiedene Faktoren verfälscht. Dazu zählt die Instrumentenfunktion („Response“) von 

Teleskop, Spektrograf und Kamera, sowie Absorption und Streuung an interstellarem Staub und Molekülen in 

der Erdatmosphäre. Zusammengefasst spricht man von einem Pseudokontinuum.  

Auf zwei verschiedene Arten können diese Einflüsse beseitigt werden: Normierung auf „1“ oder 

Flusskalibrierung. 

 

10.1 Pseudokontinuum entfernen 
Unter der Normierung eines Spektrums versteht man die Eliminierung des pseudokontinuierlichen Anteils im 

Spektrum (Continuum Removal), so dass nur noch die Spektrallinien im Spektrum verbleiben.  

Subtraktion des Kontinuums: Hat den Nachteil, dass bei einer Subtraktion die relativen Intensitäten der 

Spektrallinien zueinander nicht stimmen. Wird in der Regel nicht angewendet. 

Division durch das Kontinuum: Die relativen Intensitäten bleiben erhalten, das Divisionsergebnis ergibt im 

Spektrum im Idealfall einen exakt horizontalen Verlauf, dessen Intensität den Wert „1“ aufweist. Deshalb 

spricht man auch von der Normierung auf „1“. Dies wird im Folgenden beschrieben. 

Durchführung einer Normierung:  

➔ Spektrum 02:   Cas aktivieren 

➔  Continuum and Response Shaper  

anwenden auf 02   Cas 

➔ Free Draw wählen 

 

➔ Kästchen setzen per Doppelklick entlang des Kontinuums.  

 

➔  Refresh aktualisiert das Bild. Kästchen löschen mit 

mittlerer Maustaste. Spektrallinien großzügig überbrücken, ohne 

die Flügel der Linien zu kappen. Die so definierte orangene Kurve 

ist die sogenannte Instrumentenfunktion, meist auch als Response 

bezeichnet.  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔ Die orangene Kurve ist das Pseudokontinuum (Response) 

 

➔ Save as Continuum Removal for: 02   Cas 

 

 

➔ Normierung direkt anwenden: Abfrage mit Ok beantworten 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

Ergebnis: Das (vorläufig) normierte Spektrum mit einem etwas erhöhten Rauschen oberhalb 7500Å. 

 
 

➔ Nun den Wellenlängenbereich eingrenzen mit der Maus 

von ca. 3600Å bis 8000Å 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

➔ Falls das durchschnittliche Kontinuum in Bereichen NICHT auf einer horizontalen Linie liegt, kann die 

Datei response_norm.dat nochmals editiert werden. 

 

➔     Response -> Edit 

 

 

 

 

 

 

 

 

 

➔ Target Profile: 02   Cas 

➔ Free Draw 

➔ Neue Kästchen können 

gesetzt und/oder alte 

entfernt werden 

 

 

 

 

 

 

 

 

 

 

➔ Save  

 

➔ Ok 

➔  Projekt zwischendurch immer mal speichern:  gamma_Cas_200L.bass 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

 

Ansicht Vorher/Nachher: Wie sieht das Profil mit bzw. ohne Kontinummsbeseitigung aus?  

 

➔  Profile Properties  

 

➔ Response 

 

➔ Continuum Removal <-> No Response Correction 

 

➔ Jeweils Apply 

 

 

 

 

 

 

 

 

10.2 Normierung auf „1“ 
„Normierung auf 1“ bedeutet, dass das Kontinuum auf den Wert 1 festgelegt wird. Die rote Linie wurde hier 

in diesem Bild per Hand eingezogen, um zu zeigen, wo ungefähr das Intensitätsniveau 1 liegen soll. Eine höchst 

subjektive Einschätzung, die eine gewisse Erfahrung des Spektroskopikers erfordert.  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Spektrum 02:   Cas an die erste Position setzen  

➔ Mit rechter Maustaste in das  Cas Spektrum klicken 

➔ Sequence 

➔ 01 auswählen 

 

 

 

 

 

 

 

Unerwünschte Bereiche links und rechts des Spektrums ausgegrenzen. Ein vollständiges Entfernen aus dem 

Datensatz ist in dieser späten Phase aber nicht mehr möglich! 

➔ Mit der linken Maustaste das Spektrum wie gewünscht eingrenzen 

 

 

➔   Crop X-Axis Range  

➔ Wellenlängenbereich eingrenzen mit der Maus von 

ca. 3600Å bis 8000Å 

➔ Apply 

➔   File -> Save Project File 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Normierung auf „1“ durchführen: 

 

➔ Image  

➔ Normalize Flux Scale 

➔ Im Spektrum einen Bereich definieren, der den Wert 1 erreichen soll. Hier bei ca. 5500Å-5800Å 

➔ Falls unzufrieden mit der Lage der „1“-Linie, neue Start- oder Endwerte eingeben und Apply drücken. 

➔ Falls zufrieden: Close 

 

Hinweis: Die Normierung auf „1“ ist ein höchst 

subjektiver Vorgang, der von jedem Bearbeiter mit 

einem anderen Ergebnis durchgeführt und beurteilt 

wird.  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

10.3 Manuelle Skalierung der Y-Achse (Flux, relative Intensität) 
Die manuelle Skalierung der Y-Achse (Flux) des Spektrums von  Cas beträgt in diesem Beispiel 0 bis 4:  

 

 

➔   Profile Properties 

 

➔   Save Property Settings 

 

➔ Apply 

 

➔ Ok 

 

 

 

 

 

Ergebnis: Das auf „1“ normierte Sonnenspektrum, in der Intensität von 0 bis 4 skaliert. Das Referenzspektrum 

bleibt ausgeblendet. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

10.4 Identifikation von Spektrallinien im Spektrum von  Cas 
Die physikalischen Angaben zu  Cas streuen je nach zitierter Quelle1.  Cas ist ein rund 25.000K heißer, früher 

B-Stern der Leuchtkraftklasse IV mit etwa 17 Sonnenmassen und einem Radius von 10 Sonnenradien.  

 

 

Die charakteristischen Wasserstoffemissionen entstehen in einer zirkumstellaren, rotierenden Scheibe infolge 

Photoionisation und Rekombination der Elektronen des Wasserstoffs. Die Tabelle zeigt die relative Häufigkeit 

ausgewählter Atomsorten, deren Linien man im Spektrum erkennen kann. Die Temperatur der Scheibe beträgt 

9.500K ± 1.000K2.   

 

 

 

 

 

 

 

 

Das Spektrum von  Cas zeigt neben den prominenten Emissionslinien H und H viele Linien schwererer 

Elemente. Diese sind in einem niedrig aufgelösten Spektrum manchmal nicht eindeutig zuzuordnen.  

Zur Identifikation wurde ein Vergleichsspektrum von Richard Walker3 herangezogen. Dieser hat  Cas mit dem 

DADOS und dem 200er-Gitter aufgenommen und klassifiziert. 

  

 
1 THE THERMAL STRUCTURE OF THE CIRCUMSTELLAR DISK SURROUNDING THE CLASSICAL BE STAR γ CASSIOPEIA 
https://arxiv.org/pdf/0706.4036.pdf 
2 Hony, S., Waters, L.B.F.M., Zaal, P.A., de Koter, A., Marlborough, J.M., Millar, C.E., Trams, N.R., Morris, P.W., & 
de Graauw, Th. 2000 A&A, 355, 187 
3 Walker, Richard: Spectral Atlas for Amateurs (Cambridge University Press, 2017) 
 

© Bernd Koch 

 (Tsih) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

➔  Profile Properties. Zunächst wird die 

Skalierung der Intensitätsachse verändert, 

damit die Spektrallinien besser erkennbar 

sind. 

➔ Manual Scaling 0.9 … 1.5 

 

 

 

 

 

➔   Measurements and Elements 

➔ Zuerst fügen wir die Markierungen für die Balmerserie ein. Dazu werden nacheinander die 

Tabelleneinträge von H bis H11 angeklickt und mit Add hinzugefügt. 

➔ Hinweis: Die leichte Abweichung in der nominellen Position liegt an der Wellenlängenkalibrierung 

ohne Stützstellen unterhalb von 4500Å aufgrund fehlender markanter Linien der Neon/Xenon-

Lampe. Eine Nachkalibrierung mit Linien der Balmerserie würde aber nicht zu den Ruhewellenlängen 

der Kalibrierlampe passen und wird daher im Folgenden unterlassen.  

 

➔ Nun wird als Element File die umfassendere Sammlung AllElements.dat gewählt und davon Helium 

He. Eingrenzen oder Auswählen der Linien He I 4471.48, 5015.68, 5875.97, 6678.15. 

➔ Und zum Abschluss das Element Eisen (Fe) 

➔ Hinweis: Eine Entfernung eines einzelnen Eintrags ist in dieser Funktion nicht möglich. Das 

Editieren/Löschen/Hinzufügen kann später erfolgen, wenn die Beschriftung verfeinert wird (Labels).  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

10.5 Beschriftung des normierten Spektrums  
 

➔  Label the chart 

➔ Manage Labels 

➔ Save Set 

➔ Erzeuge, falls nicht vorhanden, unter C:/astrobodger einen neuen Ordner Labels und speichere darin 

die Datei gamma Cas norm.lbl. 

 

 

 

 

 

 

 

 

 

 

 

Beispiel zum Editieren der Einträge: 

➔ Klicken auf Eintrag des Labels Num 0019 HE[1] 6678.15 und editieren zu He I 6678.15. bestimmt die 

vertikale Position des Labels  

Die Zahl Relative Intensity gibt die rel. Höhe der Beschriftung an (-> ausprobieren). 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              42 

 

 
Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

10.6 Labelset abspeichern 
 

➔   Label the chart -> Manage Labels -> Save Set 

➔ Labelset gamma Cas norm.lbl speichern 

 

 

 

 

 

Das Labelset gamma Cas norm ist vom Autor in 

dieser Stufe mit 19 Linien bestückt worden. Das 

Set kann editiert und mit weiteren Einträgen 

ergänzt werden. Die Datei liegt als Text-Datei im 

Ordner c:/astrododger/Reference  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Beispiel: Neues Label im Hochformat hinzufügen 

➔   Farbe und Ausrichtung wählen 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Über der Spitze der H-Linie klicken und Text editieren. 

 

➔ Beispiel: H 4861.33Å. Hinweis: Ein Ängstrom-Zeichen Å findet man unter  „Linke ALT-Taste  0197“.  

 

➔ Hinweis:  Wavelength ist nur die Position 

der Beschriftung im Spektrum. Hat nichts 

mit der realen Wellenlänge zu tun. 

 

➔ Speichern. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Ergebnis: Ein mit Labels beschriftetes Spektrum 

 

➔   File -> Save Project File gamma Cas 200L.bass 

 

  

 

 

 

 

 

 

 

➔  Crop X-Axis Range 3600….6800 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

 

10.7 Notizen erstellen, einblenden und Hintergrund gestalten 
Die griechischen Buchstaben kopiert man zuerst  aus dem Label-Menü  

➔  Chart Settings 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

10.8 Speichern: Projekt – Profil – Chart – Image Strips 

➔   Speichern des Projekts mit allen Skalierungen und Beschriftungen:    gamma_Cas_200L.bass 

 

➔  Speichern des Spektralprofils (_1D), um 

es bsp. in VisualSpec oder MIDAS zu 

verarbeiten:  gamma Cas _1D.fit 

 

 

 

 

 

➔ Speichern des synthetischen Spektrums von gamma Cas und der Referenzlampe zusammen unter 

gamma Cas.png 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

  

➔
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

 

➔  Chart Settings 

 

➔ Save Chart to File: gamma 

_Cas_200L_Chart.png 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

11. Flusskalibrierung mit einem kalibrierten Referenzstern 
 

Unter dem Begriff der Flusskalibrierung versteht man eine Intensitätskalibrierung, die die relative Intensität 

bei der jeweiligen Wellenlänge korrekt wiedergibt. Relativ auf einen normierten Bereich bezogen, nicht in 

absoluten physikalischen Einheiten. 

Mit etwas Erfahrung kann man die Flusskalibrierung parallel zur Normierung in einem Arbeitsblatt 

durchführen. Zur Sicherheit erstellen wir aber eine Kopie der bisherigen Arbeit und arbeiten mit dieser weiter. 

➔ File -> Save Project or Bundle 

➔ gamma_Cas_200L_flux.bass ist eine Kopie der bisherigen wellenlängenkalibrierten Datei. 

 

➔   Löschen der Labels: Manage Labels -> Clear 

➔  Profile Properties: 01  Cas -> Automatic Scaling 100% 

➔ Response: “No Response Correction” 

➔ OK 

➔  Save Project File gamma_Cas_200L_flux.bass 

➔ Dies ist unsere Ausgangsdatei für die Flusskalibrierung  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

11.1 Öffnen und dividieren eines flusskalibrierten Referenzspektrums 
 

Um die Intensität absolut kalibrieren zu können, ziehen wir ein bereits flusskalibriertes Spektrum eines Sterns 

heran. Aber nicht ein beliebiges, sondern eines von einem Stern (nahezu) desselben Spektraltyps wie  Cas (B0 

IV). 

➔  Add a Reference Spectrum Profile 

 

 

 

 

 

 

 

 

 

 

 

➔ Pickles-Datenbank. Wähle a0v. (Es gibt hier kein A0 IV-Spektrum!). Wir nehmen es dennoch, weil es 

weiter in den IR-Bereich reicht als das Spektrum aus der MILES-Datenbank.  

 

➔ Add Spectrum to Chart 

➔ Close 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Das hier grün dargestellte Spektrum #03 B0 V Reference Spectrum ist ein vollständig flusskalibriertes Spektrum 

aus der PICKLES-Datenbank, aus dem die auf Absorption in der Erdatmosphäre beruhenden tellurischen 

Linien/Banden des Sauerstoffs und Wasserdampfs bereits entfernt worden sind. Das Strahlungsmaximum des 

Referenzsterns liegt weit vor 3600Å im UV-Bereich. 

 

Falls die Spektren nicht gut sichtbar dargestellt werden, bitte die Skalierung der Y-Achse (Intensität) 

überprüfen. 

 

➔  Profile Properties  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Zur Ermittlung des Pseudokontinuums („Response“) werden beide Spektren nun durcheinander dividiert: 

 

➔ Perform this operation: Divide Profiles 

 On this Profile: 01: γ Cas 

 Using this profile: 03 B0V Reference Spectrum 

➔ Ok 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Divisionsergebnis: 04 Divide Profile g Cas by B0 V Reference Spectrum 

 

 

 

04 Divide Profile g Cas by B0 V Reference Spectrum muss das Aktive sein: 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Nun wird das Divisionsergebnis #04 geglättet mit einem Polynom, welches nur den Kontinuumsverlauf 

nachzeichnet. 

 

Falls im Folgenden dazu aufgefordert, wird das Spektrum gespeichert: 

 

 

➔ Ok 

 

➔   Save Divide Profile g Cas by B0V Reference Spectrum  

 

 

 

 

 

 

 

 

 

➔ Speichern 

➔ Save Project File 

Nun erfolgt die Glättung von 04 Divide Profile g Cas by B0 V Reference Spectrum 

 

➔  Continuum & Response Shaper 

➔ Target Profile: 04 Divide Profile g Cas by B0 V Reference 

Spectrum 

➔ Free Draw 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

➔ Punkte setzen entlang des Kontinuums des 

Spektrums 04 Divide Profile g Cas by B0 V 

Reference Spectrum. Das berechnete Polynom 

mit den gesetzten Stützstellen ist hier in der 

Farbe Orange sichtbar. 

➔ Löschen von Punkten mit Doppelklick auf das 

Mausrad 

 

 

 

 

➔ Save 

➔ Save as response DAT file …  

➔ response_flux.dat 

➔ close 

 

 

 

 

 

 

 

 

Die Datei response_flux.dat ist das geglättete 

Divisionsergebnis und stellt nun eine 

Korrektur dar, die wir auf das Spektrum von 

 Cas anwenden müssen: 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

11.2 Flusskalibrierung mit response_flux.dat 
 

Bildschirm aufräumen: Spektren mit Hide Profile from Chart: 

 

➔ Nr. 2 ausblenden: Hide Profile from Chart 

 

➔ Nr. 3 ausblenden: Hide Profile from Chart 

 

➔ Nr. 4 ausblenden: Hide Profile from Chart 

 

➔ Nr. 1 muss aktiv sein 

 

 

➔ Profile Properties: 01:  Cas 

➔ Response -> Response File: response_flux.dat öffnen 

➔ Apply 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Ergebnis: Das eigene flusskalibrierte  Cas Spektrum 

 

 

➔  Profile properties: 01:  Cas 

Man kann nun hin- und herschalten zwischen:  

➔ No Response Correction (unkalibriertes Spektrum) 

➔ Response File (flusskalibriert, Flux) 

➔ Continuum Removal (Normierung) 

 

➔ Speichere Spektrum mit Response File 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

11.3 Speichern: Projekt – Profil – Chart – Image Strips 
 

➔  Save Project File 

 

Hinweis: Falls eine andere Speicheraufforderung kommt, bitte zunächst mit Diskettensymbol  speichern. 

Normierung des Spektrums im Bereich 5500Å bis 5550Å 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

➔ Ergebnis: Flusskalibriertes Spektrum von 01:  Cas 

 

Skalierung der Y-Achse von 0 bis 6: 

➔  Profile Properties 01:  Cas 

➔ Y-Axis 

➔ Manual Scaling 0 bis 6 

➔ Apply 

➔ Ok 

 

 

 

 

 

➔ Speichern:  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

11.4 Beschriftung des flusskalibrierten Spektrums 
 

➔  Add Label to chart   -> Manage Labels -> Load Set 

 

➔ Labelset gamma Cas norm.lbl öffnen 

 

 

 

 

 

 

 

Das vorhandene Labelset war ausgerichtet auf das zuvor normierte Spektrum. Wir richten es neu aus und 

speichern es als neues Labelset für das flusskalibrierte Spektrum. 

Einträge in diesem Labelset sind editierbar! Man kann weitere Einträge vornehmen. 

 

 

➔ Save Set 

➔ Labelset gamma Cas flux.lbl  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

11.5 Abspeichern des beschrifteten Spektrums 
 

➔ Chart 

➔ Save Chart to file 

 

 

 

 

 

 

 

 

Vorsicht: Dateiendung png oder jpg, ABER NICHT bass 

 

➔ Rechte Maustaste: Show Notes here (an gewünschte Stelle setzen) und editieren. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

11.6 Anpassung einer Planckschen Strahlungskurve 
 

 Cas hat eine Oberflächentemperatur von ca. 25.000K4 

➔  Add a Planck temperature curve  

Wellenlänge des Strahlungsmaximums und Effektivtemperatur bestimmen die Lage des Strahlungsmaximums 

gemäß dem Wienschen Verschiebungsgesetz. „Height“ und „Offset“ sind willkürliche Parameter für die 

relative Anpassung, die aber niemals optimal gelingen kann: Sterne sind keine perfekten Schwarzen Strahler. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
4 https://www.aanda.org/articles/aa/pdf/2003/35/aa3846.pdf 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

12. Übertragung des Projekts an einem anderen Ort („Bundles“) 
 

BASS arbeitet projektbezogen. Das bedeutet, dass alle für das Projekt benötigten oder erstellten Dateien einen 

festen Pfad besitzen und in einem festen Ordner, hier C:/astrobodger/ … vorhanden sein müssen. Deshalb 

findet die Kalibrierung gemäß Tutorial ausschließlich im Ordner c:/astrobodger/gamma Cas/2013-10-24 statt.   

Frage: Wie überträgt man die ursprüngliche Kalibrierung .bass von C:/astrobodger/ … auf eine andere 

Festplatte und/oder in einen anderen Ordner, um sie von dort aus aufrufen zu können?  

Antwort: Man öffnet wie gewohnt in C:/astrobodger/gamma_Cas/2013-10-24/die BASS-Datei (Beispiel: 

gamma_Cas_200L_flux.bass und speichert das Projekt im neuen Ordner wie folgt als „Bundle“ ab: 

 

Speichern als Bundle am neuen Ort:  

➔ File 

➔ Save Project or Bundle 

➔ D:/…./gamma Cas/gamma_Cas_200L_flux.bun 

Entpacken des Bundles am neuen Ort  

➔ File 

➔ Open Project or Bundle 

➔ D:/…./gamma Cas/gamma_Cas_200L_flux.bun 

Dort öffnet man die .bass-Datei des Projekts und arbeitet wie gewohnt weiter. 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              64 

 

 
Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

13. BeSS Settings (optionale Dateneintragung in 1D-Datei) 
Vergleichsspektren von Be-Sternen findet man bsp. in der BeSS-Datenbank http://basebe.obspm.fr/basebe/ 

Das eigene auf 1 normierte Spektrum muss BeSS-kompatibel abgespeichert werden, bevor man es in die 

Datenbank (nach Anmeldung) hochladen kann. Dazu muss der Datensatz neu als 1D-Spektrum abgespeichert 

werden. Danach kann man in den BeSS Settings Angaben zu Beobachter und Objekt eintragen. 

 

 

 

 

Hinweis: Niedrig aufgelöste Spektren wie 

dieses von  Cas gamma Cas_1D.fit sind zur 

genaueren Profilanalyse allerdings 

ungeeignet. In einem weiteren Tutorial zu  

Cas werden wir ein höher aufgelöstes 

Spektrum auswerten. 

 

Nach Sichern der bisherigen Arbeit wird BASS neu gestartet und die Datei gamma Cas_1D.fit geöffnet. 

BeSS Settings  

 

 

 

Site Location: Geografische Koordinaten des Beobachtungsorts eintragen.  
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Object name: gamma Cas. Bei Simbad online nach den Daten suchen lassen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Prüfe Start und Endzeit der Aufnahmeserie 

 

 

 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              66 

 

 
Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Tsih ( Cas, B0 IVe)  

mit der Conrad Magic Plasma Röhre (Neon/Xenon) 

Berechnung der heliozentrischen Korrektur 
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Optional Create Profile: Ein neues Profil mit heliozentrischer Korrektur kann dargestellt und separat 

gespeichert werden: 

 

Mit Validate BeSS wird geprüft, ob die Angaben BeSS-Kompatibel sind.  
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14. Kurse zur Sternspektroskopie am CFG Wuppertal 
Das Tutorials zur Kalibrierung eines Sonne-, bzw. 

Sternspektrums werden in den Kursen des Autors 

(rechts im Bild) am Carl-Fuhlrott-Gymnasium in 

Wuppertal zur Sternspektroskopie eingesetzt. Im 

Rahmen des Kurses wird u.a. das 

Tageslichtspektrum mit insgesamt sieben zur 

Verfügung stehenden DADOS-Spektrografen und 

ebenso vielen STF-8300M CCD-Kameras aufgenom-

men und für die Kalibrierung mit BASS vorbereitet.  

Die seit 2011 verwendete Software VisualSpec wird 

nur noch hin- und wieder herangezogen.  

Aktuelle Kursinformationen finden Sie unter:  

https://www.baader-planetarium.com/de/blog/aktuelle-spektroskopie-kurse-am-schuelerlabor-astronomie/ 

 

 

 

 

 

 

 

 

 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de
https://www.baader-planetarium.com/de/blog/aktuelle-spektroskopie-kurse-am-schuelerlabor-astronomie/

